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Paper Set 1 · 23 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A man can row at 13 km/hr in still water. When the river flows at 3
km/hr, it takes him 60 minutes to row to a certain place and return.
How far is the place? (Round off to two decimal places)

A.  4.12 km

B.  5.13 km

C.  6.15 km

D.  7.17 km

✓

Q2 Quant

The area of an equilateral triangle ABC is 36√3 cm2, find the length
of side AC (in cm).

A.  36

B.  16

C.  12

D.  9

✓

Q3 Quant
A and B started a business by investing ₹3,500 and ₹2,000,
respectively. After 7 months, B left the business and C joined the
business with a sum of ₹1,500. The profit earned at the end of year
is ₹508. What is the share of C in the profit?

A.  ₹50

B.  ₹60

C.  ₹70

D.  ₹80

✓

Q4 Quant
Arjun sells an article at a loss of 24%. If the cost price of the article is
₹3800, then what is the selling price (in ₹)?

A.  2880​​​​​​​

B.  2888

C.  2850

D.  2808

✓

Q5 Quant
If the price of a pen is decreased by 25%, its sale increases by 20%.
Find the percentage change in its revenue.

A.  Decrease of 10%

B.  Increase of 10%

C.  Decrease of 5%

D.  Increase of 5%

✓

Q6 Quant
The HCF of two numbers is 14, and their LCM is 294. If one number
is 42, what is the other number?

A.  98

B.  92

C.  86

D.  104

✓

Q7 Quant
A boat covers 48 km downstream in 2 hours and 36 km upstream in
3 hours. How much time will it take to cover 126 km in still water?

A.  5.5 hours

B.  6 hours

C.  6.5 hours

D.  7 hours

✓

Q8 Quant
A tap can fill a tank in 8 hours. Due to a leak at the bottom, it takes
10 hours to fill the tank. Find the time the leak will take to empty the
completely filled tank.

A.  24 hours

B.  30 hours

C.  36 hours

D.  40 hours

✓

Q9 Quant
The mean of a data set is '3a' and the median is '2a'(a>0). Using the
empirical relation, the mode of the dataset is:

A.  a

B.  2a

C.  0

D.  3a
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✓

Q10 Quant
A man loses 20% of his money. After spending 27% of the remaining
amount, he has ₹511 left. What was the amount of money he
originally had?

A.  ₹860

B.  ₹865

C.  ₹870

D.  ₹875

✓

Q11 Quant
Three friends P, Q and R started a business by investing a sum of
money in the ratio of 2 : 4 : 5, respectively. After 6 months Q
withdraws half of his capital. If the sum invested by P is ₹43000, out
of a total annual profit of ₹45000 find the share of Q in profit.

A.  ₹13500

B.  ₹14630

C.  ₹15165

D.  ₹12710

✓

Q12 Quant
A shopkeeper fixes the marked price of an item at 55% above its
cost price. What percentage of discount on the marked price should
be allowed to gain 24%?3006

A.  20%

B.  23%

C.  18%

D.  19%

✓

Q13 Quant

If ₹67,000 is invested at 6% per year for 2 years, what is the
difference between the compound interest (compounded annually)
and the simple interest?

A.  ₹241.20

B.  ₹237.80

C.  ₹239.80

D.  ₹248.20

✓

Q14 Quant
AB is parallel to CD. A transversal PQ intersects AB and CD at E and F,
respectively, and ∠PEB = 79°. G is a point between AB and CD such
that ∠BEG = 18° and ∠GFE = 17°. What is the measure of ∠EGF?1934

A.  80°

B.  72°

C.  86°

D.  70°

✓

Q15 Quant
If the heights of two cones are in the ratio 7 : 3 and their radius are
in the ratio 2 : 7, what is the ratio of their volumes?

A.  4:21

B.  4:35

C.  4:11

D.  4:7

✓

Q16 Quant
In what time (in months) will ₹3,000 fetch an interest of ₹420 at 6%
per year simple interest?

A.  28

B.  25

C.  26

D.  32

✓

Q17 Quant
A, B, C alone can do a piece of work in 7 days, 5 days and 17.5 days
respectively. If they all started the work together, in how many days
the whole work will be completed?

A.  2.5

B.  3.5

C.  3

D.  2
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✓

Q18 Quant

A.  

B.  

C.  

D.  

✓

Q19 Quant
The solution of the given system of linear equations is ______.
x + y - z = 0
3x - y + 3z = -2
x + 2y - 3z = -1

A.  

B.  

C.  

D.  

✓

Q20 Quant

A.  24

B.  22

C.  20

D.  28
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GA

✓

Q21 GA
Who among the following became the first Indian to score centuries
in all formats of women’s international cricket in June 2025?

A.  Harmanpreet Kaur

B.  Smriti Mandhana

C.  Mithali Raj

D.  Jemimah Rodrigues

✓

Q22 GA
Who among the following is the first Indian to set foot on the
International Space Station (ISS)?

A.  Ajit Krishnan

B.  Prasanth Nair

C.  Angad Prathap

D.  Shubhanshu Shukla

✓

Q23 GA
Ansupa Lake, the largest freshwater lake in Odisha, is located in
which of the following districts?

A.  Cuttack

B.  Khordha

C.  Puri

D.  Ganjam

✓

Q24 GA
Under which scheme were direct flight services from Biju Patnaik
International Airport in Bhubaneswar to Abu Dhabi launched, in
June 2025?

A.  Nextgen Aviation for Bharat Nirman scheme

B.  Support and Augmentation for Growth of Air Routes scheme

C.  National Aviation Facilitation and Route Expansion scheme

D.  Building Management of Aviation Assets and Network
scheme

✓

Q25 GA
Ravenshaw College (now Ravenshaw University, Cuttack) was
founded in:

A.  1906

B.  1912

C.  1868

D.  1936

✓

Q26 GA
Which of the following is an example for molecules of compounds?

A.  Hydrogen

B.  Oxygen

C.  Carbon

D.  Water

✓

Q27 GA
When an object moves at a constant speed along a circular path,
what continuously changes?

A.  Speed

B.  Direction of motion

C.  Mass

D.  Energy

✓

Q28 GA
Which of the following correctly matches the condition with the
cause in relation to growth hormones in human beings?

A.  Dwarfism – Excess growth hormone

B.  Gigantism – Lack of growth hormone

C.  Dwarfism – Deficiency of growth hormone

D.  Gigantism – Lack of thyroid hormone

✓

Q29 GA
Pratik Maharana (Odisha sprinter) set a new meet record in the U20
men’s 200 m at the 40th National Junior Athletics Championships
2025. His winning time was:

A.  21.50 s

B.  21.30 s

C.  21.24 s

D.  20.99 s

✓

Q30 GA
Approximately what percentage of India's total rainfall occurs during
the Southwest Monsoon season?

A.  About 25%

B.  About 50%

C.  About 75%

D.  Nearly 100%
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Q31 GA
The World Health Summit 2025 was held in Berlin under which
theme?

A.  “Innovations for Health Justice”

B.  “Global Health for All by 2030”

C.  “Taking Responsibility for Health in a Fragmenting World”

D.  “Science & Solidarity for Health in a Fragmenting World”

✓

Q32 GA
The Taiwan Strait connects which of the following seas?

A.  East China Sea and South China Sea

B.  Yellow Sea and Philippine Sea

C.  South China Sea and Philippine Sea

D.  Sea of Japan and Yellow Sea

✓

Q33 GA
Geothermal energy is obtained from what primary source?

A.  The thermal energy of ocean currents

B.  The solar energy absorbed by the Earth's crust

C.  The internal heat of the Earth

D.  The kinetic energy of tectonic plates

✓

Q34 GA
Who is excluded from initiating a constitutional amendment bill
under Article 368 under Indian constitution?

A.  State legislatures

B.  Private members of Parliament

C.  Union Ministers

D.  Parliament of India

✓

Q35 GA
Which of the following best describes the significance of the
notification of the Digital Personal Data Protection (DPDP) Rules,
released on November 14, 2025, by the Government of India?

A.  All existing data protection laws in India

B.  The partial implementation of the DPDP Act, 2023

C.  Citizen-centred framework for responsible data use

D.  Focused exclusively on restricting the processing data

✓

Q36 GA
If a traveller wants to visit a site of historical significance in Port
Blair, which location should they choose?

A.  Cellular Jail

B.  Marine Museum

C.  Zoological garden

D.  Anthropological Museum

✓

Q37 GA
In context to Indian literature, which one of the following texts is a
part of Buddhist literature and contains the teachings of Gautama
Buddha?

A.  Rigveda

B.  Upanishads

C.  Tripitaka

D.  Samaveda

✓

Q38 GA
Which of the following works by Rabindranath Tagore won the
Nobel Prize for Literature in 1913, contributing to global recognition
of Indian literary heritage?

A.  Gitanjali

B.  Chokher Bali

C.  Ghare-Baire

D.  Gora

✓

Q39 GA
Chenab Bridge, world’s highest railway bridge, connects which
Indian region through the Udhampur-Srinagar-Baramulla Rail Link
Project?

A.  Kashmir with the rest of the country

B.  Arunachal Pradesh with the rest of the country

C.  Himachal Pradesh with the rest of the country

D.  Sikkim with the rest of the country

✓

Q40 GA
The Doctrine of Lapse, introduced by Lord Dalhousie, was used to
justify:

A.  Promotion of education

B.  Removal of Indian princes without heirs

C.  Employment of Indians in civil services

D.  Collection of land revenue directly
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English

✓

Q41 English
What is the term used to describe language that is characterised by using few words packed with meaning and is concise?

A.  Soliloquy

B.  Whimsical

C.  Laconic

D.  Serendipity

✓

Q42 English
Select the correct future tense form of the given sentence.

The teacher checks the answer sheets every Monday.

A.  The teacher was checking the answer sheets every Monday.

B.  The teacher will check the answer sheets every Monday.

C.  The teacher had checked the answer sheets every Monday.

D.  The teacher checks the answer sheets every Monday.

✓

Q43 English
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a meaningful and coherent
paragraph.

A. Scientists warn that rising temperatures could lead to severe consequences.
B. It is essential for individuals to contribute by adopting sustainable practices.
C. Climate change has become one of the most pressing global issues.
D. Governments around the world are implementing measures to reduce carbon emissions.

A.  C - A - D - B

B.  C - D - A - B

C.  A - C - D - B

D.  D - A - C - B

✓

Q44 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. project can be great ways to start moving more when you have
B. activities such as gardening or tackling a home improvement
C. a mood disorder—as well as helping you become more active;
D. they can also leave you with a sense of purpose and accomplishment

A.  BACD

B.  ACBD

C.  ABCD

D.  DCAB

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q45 English
Choose the correct idiom to replace the underlined part of the following sentence.
We need to handle this difficult situation very carefully.

A.  put our best foot forward

B.  walk on eggshells

C.  hit the nail on the head

D.  run around in circles

✓

Q46 English
Select the most appropriate antonym of the underlined word in the given sentence.

She was provoked by his behaviour.

A.  avoided

B.  appeased

C.  reprimanded

D.  delayed

✓

Q47 English
Select the most appropriate idiom to replace the capitalised words in the sentence below.

The principal appreciated the students for being HONEST AND FRANK during the investigation.

A.  above board

B.  by leaps and bounds

C.  in cold blood

D.  a hard nut to crack

✓

Q48 English
Complete the following sentence in direct speech.

__________ said the literary critic.

A.  "My favourite book is The Odyssey,"

B.  Book that was Odyssey was his favourite

C.  The Odyssey Book was my favourite

D.  Odessey was his favourite book

✓

Q49 English
Choose the option that correctly converts the given passive sentence into the active voice.

The manuscript was reviewed thoroughly by the editor.

A.  The editor reviewed the manuscript thoroughly.

B.  The editor was reviewing the manuscript thoroughly.

C.  The manuscript reviewed the editor thoroughly.

D.  The editor has reviewed the manuscript thoroughly.
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✓

Q50 English
Complete the sentence by selecting the appropriate option.

The manager insisted ______ punctuality and showed little tolerance ______ repeated delays among the staff.

A.  on, for

B.  in, with

C.  for, on

D.  with, to

✓

Q51 English

Read the passage and answer the questions that follow.

Time management is a crucial skill that significantly influences a student’s academic and personal success. Students who plan their daily activities
effectively are able to balance studies, extracurricular activities, and leisure without feeling overwhelmed. By setting clear goals and prioritising
tasks, they can complete assignments on time and reduce unnecessary stress. Moreover, proper time management enhances productivity and
allows students to make better use of available resources. It also improves concentration, as organised schedules minimise distractions and
confusion. Students who manage their time wisely often develop a sense of discipline and responsibility, which benefits them in the long run.
However, poor time management can lead to missed deadlines, anxiety, and decreased performance. Many students struggle because they
procrastinate or fail to organise their tasks efficiently. Therefore, developing good time management habits is essential for achieving academic
excellence and maintaining a balanced lifestyle.

Identify a suitable title for the passage.

A.  The Challenges Faced by Students in Modern Education

B.  The Role of Teachers in Guiding Student Activities

C.  The Influence of Extracurricular Activities on Students

D.  The Importance of Planning and Discipline in Student Life

✓

Q52 English
Which of the following statements is correct according to the passage?

A.  Time management helps students complete tasks on schedule.

B.  Time management removes the need for studying regularly.

C.  Students cannot improve concentration through planning.

D.  Time management is useful only for professional adults.

✓

Q53 English
Identify the tone of the passage.

A.  Critical and discouraging about student behaviour patterns

B.  Informative and advisory about managing time effectively

C.  Humorous and exaggerated about academic challenges

D.  Indifferent and neutral about student responsibilities
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✓

Q54 English
Identify the structure of the passage.

A.  Concept explained with benefits, problems, and conclusion

B.  Chronological narration of a student’s daily routine

C.  Dialogue between students discussing study techniques

D.  Argumentative debate presenting conflicting viewpoints

✓

Q55 English
Select the correct summary for the passage.

A.  Time management is difficult and unnecessary for students.

B.  Students should focus only on studies without planning.

C.  Time management improves efficiency and reduces stress levels.

D.  Time management applies only to working professionals.

✓

Q56 English
Select the most appropriate option to substitute the underlined group of words.
His mother is a person who believes in equality of all people.

A.  libratarian

B.  egalitarian

C.  conservative

D.  authoritarian

✓

Q57 English
Choose the most appropriate antonym of the underlined word in the given sentence.

The once pristine lake has now been polluted due to unchecked industrial waste.

A.  Productive

B.  Contaminated

C.  Unspoiled

D.  Evolved

✓

Q58 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

She looked at ____ moon through the telescope.

A.  a

B.  an

C.  the

D.  no article required
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✓

Q59 English
Identify the INCORRECTLY spelt word from the given sentence and select the option that mentions the incorrect spelling, followed by the
correct spelling.

The goverment announced new policies to address the economic crisis.

A.  goverment - government

B.  announced - annonuced

C.  policies - polocies

D.  crisis - crises

✓

Q60 English
Choose the best option to complete the given sentence.

By the time the conference starts, the researchers _____________ their experiments.2689

A.  will have completed

B.  will have been completing

C.  will have been complete

D.  will have be complete

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
"ସମ୍ବଲପୁ ରୀ ଶାଢ଼ୀ ଓଡ଼ି ଶାରେ ଅତି  ବି ଖ୍ୟାତ ଅଟେ ।"

A.  Sambalpuri saree is very famous in Odisha.

B.  Sambalpuri sari are famous at Odisha.

C.  The Sambalpuri sarees be very popularity.

D.  Sambalpuri saree is very fame of Odisha.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ବାଇବେଲ ଖ୍ରୀ ଷ୍ଟଧର୍ମ ର ପବି ତ୍ର  ଗ୍ର ନ୍ଥ ଅଟେ ଏବଂ ଏହା ସର୍ବ ତ୍ର  ପଢ଼ାଯାଏ ।

A.  The holy book of Christianity is called the Bible and is read worldwide.

B.  The holy book of Christianity is called Bible and read worldwide.

C.  The holy book of Christianity are called the Bible and is read worldwide.

D.  The holy book of Christianity is called the Bible and read world wide.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Rohit Sharma has scored many double centuries.

A.  ରୋହି ତ ଶର୍ମା  ଅନେକ ଦ୍ୱି ଶତକ କରି ଛନ୍ତି ।

B.  ରୋହି ତ ଶର୍ମା  ଅନେକ ଡବଲ ସେଞ୍ଚୁ ରୀ କରି ଥି ଲେ।

C.  ରୋହି ତ ଶର୍ମା  ଅନେକ ଡବଲ ସେଞ୍ଚୁ ରୀ କରେ।

D.  ରୋହି ତ ଶର୍ମା  ଅନେକ ଡବଲ ସେଞ୍ଚୁ ରୀ କରୁ ଛନ୍ତି ।
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✓

Q64 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

1951 ମସି ହାରେ ଆଚାର୍ଯ୍ୟ  ବି ନୋବା ଭାବେ ଭୂ ଦାନ ଆନ୍ଦୋଳନର ଶୁ ଭାରମ୍ଭ କରି ଥି ଲେ | ଆଧୁ ନି କ ଭାରତୀୟ ଇତି ହାସର ସବୁ ଠାରୁ  ଉଲ୍ଲେଖନୀୟ ସାମାଜି କ-ଆଧ୍ୟାତ୍ମି କ ଅଭି ଯାନ ମଧ୍ୟରୁ  ଏହା
ଅନ୍ୟତମ ଭାବରେ ପ୍ର ତୀୟମାନ ହୋଇଛି । ସେ ମହାତ୍ମା ଗାନ୍ଧୀଙ୍କ ଆଦର୍ଶ ରେ ଅନୁ ପ୍ରା ଣି ତ ହୋଇ କାର୍ଯ୍ୟ  ଜାରି  ରଖି ଥି ଲେ | ବି ନୋବା ଭାବେ ବି ଶ୍ୱାସ କରୁ ଥି ଲେ ଯେ ପ୍ର କୃ ତ ସାମାଜି କ ପରି ବର୍ତ୍ତ ନ ବଳ
କି ମ୍ବା ଆଇନ ପ୍ର ଣୟନ ଦ୍ଵାରା ହୋଇପାରି ବ ନାହିଁ ବରଂ ଏହା କେବଳ ସ୍ୱେଚ୍ଛାକୃ ତ ସହଯୋଗ, କରୁ ଣା ଏବଂ ନୈ ତି କ ପ୍ର ବର୍ତ୍ତ ନା ଦ୍ୱାରା ହିଁ ସମ୍ଭବ ହୋଇପାରେ । ଏହି  ଆନ୍ଦୋଳନ ତେଲେଙ୍ଗାନାର
ପୋଚମପାଲି  ଗାଁ ରେ ଆରମ୍ଭ ହୋଇଥି ଲା, ଯେଉଁ ଠାରେ ବି ନୋବା ଭାବେ ଭୂ ମି ହୀନ କୃ ଷକମାନଙ୍କ ପାଇଁ  ଭୂ ମି  ଦାନ ଅନୁ ରୋଧ କରି ଥି ଲେ । ତାଙ୍କ ଅନୁ ରୋଧ କ୍ର ମେ ଜଣେ ସ୍ଥାନୀୟ ଜମି ଦାର, ରାମଚନ୍ଦ୍ର
ରେଡ୍ଡୀ, ସ୍ୱେଚ୍ଛାକୃ ତ ଭାବରେ 100 ଏକର ଜମି  ପ୍ର ଦାନ କରି ଥି ଲେ, ଯାହା ଭୂ ଦାନର ଐତି ହାସି କ ଆରମ୍ଭ, ଅର୍ଥା ତ୍  "ଭୂ ମି ର ଦାନ" ବୋଲି  ଚି ହ୍ନି ତ କରାଯାଇଥି ଲା ।

ଏହି  ଆନ୍ଦୋଳନର ମୁ ଖ୍ୟ ଲକ୍ଷ୍ୟ ଥି ଲା ଭୂ ମି ହୀନ ଚାଷୀମାନଙ୍କୁ  ଜମି  ପୁ ନଃବଣ୍ଟନ କରି  ଆର୍ଥିକ ସମାନତା ଏବଂ ଗ୍ରା ମୀଣ ଉନ୍ନତି କୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା। ବି ନୋବାଭାବେ ହଜାର ହଜାର ଗ୍ରା ମକୁ
ପଦଯାତ୍ରା  କରି  ଧନୀ ଜମି ଦାରମାନଙ୍କୁ  ଶାନ୍ତି ପୂ ର୍ଣ୍ଣ  ବଣ୍ଟନ ଏବଂ ବି ଶ୍ୱାସ-ଆଧାରି ତ ସମ୍ପ୍ରଦାୟ ଜୀବନଯାପନର ବାର୍ତ୍ତା  ଦେଇ ପ୍ର ବର୍ତ୍ତା ଇଥି ଲେ । ତାଙ୍କର ନମ୍ର  ପ୍ର ବର୍ତ୍ତ ନା ଏବଂ ଆଧ୍ୟାତ୍ମି କ କରି ସ୍ମା ବ୍ୟାପକ
ଜନସମର୍ଥ ନ ଆକର୍ଷିତ କରି ଥି ଲା। ଅନେକ ଜମି  ମାଲି କ ସ୍ୱେଚ୍ଛାକୃ ତ ଭାବରେ ଗରି ବଙ୍କ କଲ୍ୟାଣ ପାଇଁ  ସେମାନଙ୍କର ଜମି ର କି ଛି  ଅଂଶ ଦାନ କରି ଥି ଲେ, ଯାହା ଏହି  ଅଭି ଯାନକୁ  ଅହିଂ ସା ସାମାଜି କ
ସଂସ୍କାରର ପ୍ର ତୀକ କରି ଥି ଲା । ଏହି  ଆନ୍ଦୋଳନ ପରେ ଗ୍ରା ମଦାନ ଆନ୍ଦୋଳନରେ ପରି ଣତ ହୋଇଥି ଲା, ଯେଉଁ ଠାରେ ସମଗ୍ର  ଗ୍ରା ମର ଲୋକମାନେ ମି ଳି ତ ଭାବରେ ଜମି  ଏବଂ ସମ୍ପଦ ବାଣ୍ଟି ବାକୁ
ପ୍ର ତି ଶ୍ରୁ ତି  ଦେଇଥି ଲେ ।

ଏହାର ମହାନ ଉଦ୍ଦେଶ୍ୟ ଏବଂ ପ୍ରା ରମ୍ଭି କ ସଫଳତା ସତ୍ତ୍ୱେ, ଭୂ ଦାନ ଆନ୍ଦୋଳନ ବହୁ  ଚ୍ୟାଲେଞ୍ଜର ସମ୍ମୁଖୀନ ହୋଇଥି ଲା। ଦାନ କରାଯାଇଥି ବା ଜମି ର ଅଧି କାଂଶ ଅକାର୍ଯ୍ୟ କ୍ଷମ, ବି ବାଦି ତ କି ମ୍ବା କେବେ
ଆଇନଗତ ଭାବରେ ହସ୍ତାନ୍ତରି ତ ହୋଇନଥି ଲା, ଯାହା ବ୍ୟବହାରି କ କାର୍ଯ୍ୟା ନ୍ୱ ୟନରେ ବାଧା ପହଞ୍ଚାଇଥି ଲା । ସମୟ ସହି ତ, ଉତ୍ସାହ ହ୍ରା ସ ପାଇଲା ଏବଂ ଆନ୍ଦୋଳନ ଧୀରେ ଧୀରେ ଦୁ ର୍ବ ଳ ହୋଇଗଲା।
ତଥାପି , ଭୂ ଦାନ ପଛରେ ଥି ବା ଏହି  ମହାନ ଉଦ୍ଦେଶ୍ୟ ସାମାଜି କ ନ୍ୟାୟର ଏକ ଶକ୍ତି ଶାଳୀ ଉଦାହରଣ ହୋଇ ରହି ଛି , ଯାହା ଆତ୍ମ-ଦାୟି ତ୍ୱ, ସହାନୁ ଭୂ ତି  ଏବଂ ସହଯୋଗ ଜୀବନଯାପନ ଉପରେ
ଗୁ ରୁ ତ୍ୱାରୋପ କରେ। ଆଜି  ମଧ୍ୟ, ବି ଦ୍ୱାନମାନେ ବି ନୋବା ଭାବେଙ୍କ ପ୍ର ୟାସକୁ  ମାନବ ସଦ୍ଭାବନା ଏବଂ ତୃ ଣମୂ ଳ ଗଣତନ୍ତ୍ରରେ ଏକ ଗଭୀର ପରୀକ୍ଷଣ ଭାବରେ ଦେଖନ୍ତି । ତାଙ୍କ ଆନ୍ଦୋଳନ ସମାନ
ସମ୍ବଳ ବଣ୍ଟନ, ସ୍ଥାୟୀ ଗ୍ରା ମୀଣ ବି କାଶ ଏବଂ ନେତୃ ତ୍ୱର ନୈ ତି କ ଦି ଗ ଉପରେ ଆଲୋଚନାକୁ  ପ୍ରେ ରଣା ଦେବା ଜାରି  ରଖି ଛି  ।

ଭୂ ଦାନ ଆନ୍ଦୋଳନ କେଉଁ  ବର୍ଷ  ଆରମ୍ଭ ହୋଇଥି ଲା?

A.  1947

B.  1951

C.  1962

D.  1930

✓

Q65 Odia
ଆନ୍ଦୋଳନ କେଉଁ ଠାରୁ  ଆରମ୍ଭ ହୋଇଥି ଲା?

A.  ୱାର୍ଦ୍ଧା

B.  ବାରାଣସୀ

C.  ପୋଚମପାଲି

D.  ଅହମ୍ମଦାବାଦ

✓

Q66 Odia
ଭୂ ଦାନ ଆନ୍ଦୋଳନର କେନ୍ଦ୍ରୀୟ ଲକ୍ଷ୍ୟ କ’ଣ ଥି ଲା?

A.  ଶି ଳ୍ପ ଉତ୍ପାଦନ ବୃ ଦ୍ଧି

B.  ଭୂ ମି ହୀନଙ୍କୁ  ଭୂ ମି  ପୁ ନଃବଣ୍ଟନକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା

C.  ସହରାଞ୍ଚଳ ଗୃ ହ ନି ର୍ମା ଣ କଲୋନୀ ସ୍ଥାପନ କରି ବା

D.  ବୈ ଦେଶି କ ବାଣି ଜ୍ୟ ବି ସ୍ତାର କରି ବା

✓

Q67 Odia
ବି ନୋବା ଭାବେଙ୍କ ଚି ନ୍ତାଧାରା କି ଏ ପ୍ରେ ରଣା ଦେଇଥି ଲା?

A.  ସୁ ଭାଷ ଚନ୍ଦ୍ର ବୋଷ

B.  ଜବାହରଲାଲ ନେହେରୁ

C.  ମହାତ୍ମା ଗାନ୍ଧୀ

D.  ବାଲ ଗଙ୍ଗାଧର ତି ଲକ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q68 Odia
ଭୂ ଦାନ ଆନ୍ଦୋଳନ ପରବର୍ତ୍ତୀ  ସମୟରେ କେଉଁ  ପଦକ୍ଷେପରେ ବି କଶି ତ ହୋଇଥି ଲା?

A.  ସମବାୟ କୃ ଷି  ଆନ୍ଦୋଳନ

B.  ଗ୍ରା ମଦାନ ଆନ୍ଦୋଳନ

C.  ସ୍ୱଦେଶୀ ଆନ୍ଦୋଳନ

D.  ଭାରତ ଛାଡ଼ ଆନ୍ଦୋଳନ

✓

Q69 Odia
ଆପଣଙ୍କୁ  ଅନୁ ରୋଧ ଧୈ ର୍ଯ୍ୟ  ସହକାରେ ବସନ୍ତୁ । ଉକ୍ତ ବାକ୍ୟରେ କ୍ରି  ୟା ବି ଶେଷଣ ଚି ହ୍ନଟ କର ।

A.  ଅନୁ ରୋଧ

B.  ଧୈ ର୍ଯ୍ୟ

C.  ସହକାରେ

D.  ବସନ୍ତୁ

✓

Q70 Odia
“ଚଟୁ  ଆଇଁ ଷ, ବେଣ୍ଟ ନି ରାମି ଷ” - ଏହି  ଲୋକୋକ୍ତି ର ଅର୍ଥ  ଲେଖ ।

A.  ପରସ୍ପର ବି ରୋଧୀ ଭାବ

B.  ଭି ନ୍ନ କାର୍ଯ୍ୟ  ପାଇଁ  ସମୟର ଭି ନ୍ନ ଭି ନ୍ନ ଉପଯୋଗ

C.  ଅକାରଣରେ କଳି  କରି ବା

D.  ଘୋର ଶତ୍ରୁ ତା

✓

Q71 Odia
"ଚି ନି ବୁ ହା ବଳଦ" - ଏହି  ରୂ ଢି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ଫଳ ଆଶା କରି  କାମ କରି ବା ।

B.  ଅଳସ ହୋଇ ରହି ବା ।

C.  ଫଳ ଭୋଗର ଆଶା ନରଖି  କେବଳ କାମ କରି ବା ।

D.  ଅନ୍ୟକୁ  କୌଣସି  କାମରେ ଠକି ବା ।

✓

Q72 Odia
"ଆକୁ ଞ୍ଚନ" ର ବି ପରୀତ ଶଦ୍ଦ କି ଏ ?

A.  ସଙ୍କୋଚ

B.  ସଂକୁ ଚନ

C.  ଆକର୍ଷ ଣ

D.  ପ୍ର ସାରଣ

✓

Q73 Odia
‘ପବନ ମନ୍ଦ ମନ୍ଦ ବହୁ ଛି |' ଏଠାରେ ' ମନ୍ଦ ମନ୍ଦ' କେଉଁ  ପ୍ର କାରର ବି ଶେଷଣ ଭାବେ ପରି ଗଣି ତ?

A.  ପୂ ରଣବାଚକ ବି ଶେଷଣ

B.  କ୍ରି  ୟା ବି ଶେଷଣ

C.  ବି ଧେୟ ବି ଶେଷଣ

D.  ଅବସ୍ଥାବାଚକ ବି ଶେଷଣ
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✓

Q74 Odia
ତୁ ମେ ସେଠି କୁ  ଶୀଘ୍ର  ଯାଅ । ଏହି  ବାକ୍ୟରେ ଠି କ୍  'କ୍ରି  ୟା ବି ଶେଷଣ' କେଉଁ ଟି  ?

A.  ଶୀଘ୍ର

B.  ଯାଅ

C.  ସେଠି କୁ

D.  ତୁ ମେ

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  ଖଡୁ

B.  କଇଁ ଛ

C.  କଣ୍ଢେଇ

D.  କର୍ଣ୍ଣ

Computer

✓

Q76 Computer
What is the function of the Tab key on the keyboard?

A.  Moves the cursor to the next tab stop

B.  Deletes the selected text

C.  Opens the file menu

D.  Saves a document

✓

Q77 Computer
Which option in the Print Settings ensures that all columns fit on
one page wide?

A.  Page Orientation

B.  Collate Pages

C.  Set Print Area

D.  Scale to Fit → Width = 1 page

✓

Q78 Computer
Which tab in Microsoft PowerPoint allows you to apply transition
effects between slides?

A.  Animations

B.  Transitions

C.  Slide Show

D.  Design

✓

Q79 Computer
Which option in MS PowerPoint (Office 2021) prevents editing of a
PowerPoint presentation?

A.  Save As

B.  Export

C.  Print

D.  Mark as Final

✓

Q80 Computer
Which web browser released in 1993 became widely known for
introducing images and a graphical interface to the internet?

A.  Mosaic

B.  Netscape Navigator

C.  Internet Explorer

D.  Opera

✓

Q81 Computer
What is the function of the Recycle Bin on a Windows desktop?

A.  Permanently deletes files from the system

B.  Runs system updates

C.  Stores deleted files temporarily before permanent deletion

D.  Helps in managing network connections
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✓

Q82 Computer
Which key combination is used to insert a new line within the same
text box in PowerPoint without starting a new bullet or paragraph?

A.  Alt + Enter

B.  Shift + Enter

C.  Enter

D.  Ctrl + Enter

✓

Q83 Computer
What is the difference between line spacing and paragraph spacing?

A.  Line spacing is within paragraphs; paragraph spacing is
between paragraphs.

B.  They are the same thing.

C.  Line spacing is for headers only.

D.  Paragraph spacing is for bullets only.

✓

Q84 Computer
In networking, LAN is an abbreviation for:

A.  Local Access Network

B.  Large Area Network

C.  Limited Access Node

D.  Local Area Network

✓

Q85 Computer
Which of the following is NOT an Internet service?

A.  Ethernet

B.  FTP

C.  World Wide Web

D.  EMAIL

✓

Q86 Computer
In MS Word 2021, which type of section break starts a new section
on the same page without moving content to a new page?

A.  Next Page

B.  Even Page

C.  Odd Page

D.  Continuous

✓

Q87 Computer
What does 'Wrap Text' do in Microsoft Excel?

A.  Allows you to concatenate the excess text within a cell

B.  Allows you to display text that exceeds the width of a cell on
multiple lines within that same cell

C.  Allows you to format the text such as change the font, colour
and size of the text within a cell

D.  Allows you to modify the text within a cell

✓

Q88 Computer
Which feature in MS Word is used to improve the readability of a
document by adjusting the vertical space between lines of text
within a paragraph?

A.  Page Borders

B.  Line and Paragraph Spacing

C.  Find and Replace

D.  Page Layout

✓

Q89 Computer
In MS Excel 2021, where can you access the settings to enable and
configure the AutoRecovery feature?

A.  File → Options → Save

B.  File → Export → Recovery Preferences

C.  Home → Recover Unsaved Workbooks

D.  Insert → Add-ins → AutoRecovery Tools

✓

Q90 Computer
Which keyboard shortcut is commonly used to access Task
Manager?

A.  Ctrl + Shift + Esc

B.  Ctrl + Alt + T

C.  Alt + Tab

D.  Ctrl + P
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✓

Q91 Reasoning
A, B, C, D, E, Y and Z are sitting in a straight line, facing north. Only Z
is between Y and B. A is second from the right end. Only two people
are sitting between C and E. C is sitting at one of the extreme ends.
Y is third from the left end and is to the immediate left of E. Who is
sitting third from the right end?

A.  D

B.  B

C.  Y

D.  E

✓

Q92 Reasoning
P is the sister of Q. A is the sister of Q. L is the brother of Q's father.
How is L related to P?2483

A.  Father’s brother

B.  Father’s brother’s son

C.  Father

D.  Father’s father

✓

Q93 Reasoning
Seven boxes Q, R, W, T, E, U and Y kept one over the other but not
necessarily in the same order.
Only Q is kept above T. Only E is kept between T and R. Only Y is kept
below W.
How many boxes are kept above U?

A.  1

B.  2

C.  3

D.  4

✓

Q94 Reasoning
Select the triad which follows the same pattern as that followed by
the two triads given below. Both triads follow the same pattern.

OH-RK-TV
LE-OH-QS

A.  IB-LE-NP

B.  IB-LE-NO

C.  JB-LE-NO

D.  JB-LF-NO

✓

Q95 Reasoning
If 1 is added to each odd digit and 1 is subtracted from each even
digit in the number 481356, then what will be the sum of all even
digits in the new number thus formed?

A.  8

B.  10

C.  12

D.  14

✓

Q96 Reasoning
Which of the following options will replace the question mark (?) in
the given series to make it logically complete?

AXTV SPLN ? CZVX URNP

A.  KHDF

B.  USMO

C.  UQMO

D.  UVXZ

✓

Q97 Reasoning
In a certain code language, ‘beach drama zip’ is coded as 'cx rs uy'
and ‘zip mango new’ is coded as ‘qu cx mo’. How is ‘zip’ coded in the
given language?

A.  qu

B.  cx

C.  rs

D.  uy

✓

Q98 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).
Statement: Some Mercuries are Venuses. No Venuses are Earths.
Conclusion I: Some Mercuries are Earths
Conclusion II: No Earths are Mercuries3956

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow
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✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
man out is not based on the number of consonants/vowels or their
position in the letter cluster)2839

A.  QU−RY

B.  DH−FJ

C.  XB−ZD

D.  RV−TX

✓

Q100 Reasoning
Each vowel in the word FRIENDSHIPS is changed to the letter
immediately preceding it in the English alphabetical order AND each
consonant is changed to the letter immediately following it in the
English alphabetical order. Which of the following letters will appear
exactly twice in the group of letters thus formed?7655

A.  H

B.  O

C.  Q

D.  I
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